
Google Slides Handout
Create Presentations Online

Carol LaRow

Create presentations that users view in browser windows.  Collaborate in real time, or work when it’s 
convenient, inside a WEB browser window.

Features:

• Part of Google DRIVE
• Create presentations online, collaborate, save, and share with others
• Edit in real time; get immediate feedback
• Upload Power Point presentations from computers to “Drive” and edit
• Convert Power Point slides to Google Slides and vice versa
• See revision history
• Work from any computer
• Access anywhere, any time
• Chat and comment with editors/collaborators

Working With Google Docs:

• Sign into your Google account
• Directions for creating a Google account are available on another handout
• You need a Google account to create and 

edit in Slides

Accessing the Google Docs Tool:

• From your Google start (login) page,
• Click on the Apps Icon in the top, right corner
• Choose, “Drive”
• This will take you to the Drive Tools

Creating A New Presentation: 

• Click, “Create”
• Choose --> Presentation
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A blank presentation opens. You start by choosing 
a theme. The theme window looks like the image 
on the right. Click one of the colored themes.

After you choose your theme, you will see a 
window that looks similar to the one on the right.

Click the words, “Untitled Presentation” in the top, left of 
the screen. 

• A window opens, allowing you to enter a title
• Give the presentation a title
• You can change this later by clicking the name of 

the title again. 

1. Start adding content to the first slide
2. Start typing on the slide where it says, “Click to add title”
3. You can also add a subtitle

Re-naming A Presentation:

You can always rename your presentation or correct 
spelling errors:
• Click the plus sign in the toolbar
• Or use the menu command: File --> Rename
• A window appears; enter the new document name in the 

window
• You can also click on the title you entered in the top, left 

to open the rename box

The Toolbar:

Notice the toolbar at the top of the screen. You can use the commands in the toolbar or the menu commands.
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Saving Your Work:

You are probably used to saving your files. Google 
automatically saves your work. There is no
need to click “Save.” This is helpful if you forget to 
save your work.
 
• Notice that you will see the word, “Saving” appear 

next to the menu commands. 
• It is gray-colored text

Changing the Layout Of The Slides:

You are currently on a title slide “layout.” You can choose
other layouts for additional slides, depending on the
content you wish to enter onto your slides.

• Click the + icon in the toolbar,
• Or, use the menu command: Slide ->Layout
• You will see a drop down menu with 6 choices:

• title
• title and body
• tile and two columns
• title only
• caption
• blank

Inserting Items Onto Slides:

You can insert the following onto slides:
• text and text boxes
• images
• videos
• Word Art
• shapes and lines
• tables

You can see the different “insert” choices you have by using 
the drop down menu.

Inserting Text Box:

Insert -> Text Box:
• Click the slide and drag the mouse to create a text box
• Click inside the text box to start entering text
• You can resize the box by dragging the corners
• You can move the text box around the slide; click inside the

text box with the mouse; drag the box
• You can delete the entire text box; hit the delete key or right-click

and choose “cut.”
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Inserting Images:

Use the Menu Command: Insert -> Image

• A window opens that looks like the one on the right
• There are 6 options for inserting images:

• Upload
• Take a snapshot
• By URL
• Your albums
• Google DRIVE
• Search

Three of the options are:

1) Upload:
• You can upload an image you have saved on your hard drive.
• Click, “Upload”
• Click, “Choose an Image to Upload”
• Browser your computer to find an image
• Select the image; click, “Open”
• The image is added to your slide
• You can resize the image by using the handles on the border

2) Google Drive:
• You can insert images you have saved in your Drive.
• They can be your own images or ones shared with you
• Once you click “My Drive,” you can search the folders or list 

of files in your Google Drive
• Click on the image of your choice, and it will be inserted on 

the slide

3) Search:
• You can search for images online
• Type your search term in the box provided
• Google will use its search engine to find images online
• You can also use Life Magazine archives and stock photos
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A Word About Images: 

1. Be sure you cite sources for copyrighted material
2. Good sources for images are Creative Commons and Wikipedia; note the copyright information at these sites. 

They tell you how to properly cite your images and photos.

Inserting Videos:

• Use the Menu Command: Insert -> Video
• You will see a “You Tube” search box
• Type a topic in the box

• You will be taken to You Tube

• You can preview videos and click on the video you want
• Click, “Select”

• The video will appear on the slide in your presentation
• You can resize the video on the slide
• You can also move the video around the slide, as you would 

a text box
• You can delete the video; highlight and hit the Delete key
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• You can also add a You Tube video by URL
• Find the video you want and click “share”
• Copy the URL from You Tube and paste it in the URL window
• This is a way you can create your own videos, upload them to

your Channel on YouTube, and bring them into your 
presentation

Note: You can only insert videos from YouTube. You cannot
insert videos from your school server, for example. However,
you can link to other videos by adding text to the slide and
creating a link to that video. The video will not play on the slide.
It will play in a browser window instead.

Adding More Slides:

• You can add new slides in different ways:
• From Menu Bar, choose, Slide -> New Slide
• Or, right click on a slide thumbnail in the left sidebar 

and choose, “New Slide”

Duplicating Slides:

• To duplicate slides: 
• From Menu Bar, choose, Slide -> Duplicate Slide
• Or, right click on a slide thumbnail in the left sidebar 

and choose, “Duplicate Slide”
• Or, click the thumbnail in the left sidebar and use key 

commands:
• Mac: Command + D key
• PC: Control + D key

Deleting Slides:

• You can easily delete slides. 
• From Menu Bar, choose, Slide -> Delete Slide
• Or, right click on a slide thumbnail in the left sidebar 

and choose, “Delete Slide”
• Or, click the thumbnail in the left sidebar and hit the 

Delete key

Moving Slides:

• To move slides, click on a thumbnail in the left sidebar, and move the thumbnail to a different position.
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Editing Text:

• More of the toolbar will appear when you edit text
• The image at the right shows the toolbar before

clicking on the text
• It does not show text editing tools

• The image at the right shows the toolbar once
you have clicked on text

• Notice the blue box around the text
• It does show text editing tools
• Click, “More” to see more editing tools

Adding Transitions To Slides:

• You can add transitions to slides
• This will give a nice effect as the user

 progresses through the presentation
• From the Menu bar, choose: Slide
• A drop down menu appears
• Choose, “Slide -> Change Transition”

• A side panel appears on the right side
of the slide

• Choose a transition for the entrance of the slide
• Choices are:

• No Transition
• Fade
• Slide From Right
• Slide From Left
• Flip
• Cube
• Gallery

• You can choose a speed
• You can apply to all slides if you wish
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You can also preview how the transition works by clicking “Play” in the right sidebar.

To change transitions once you’ve made initial choices, follow the same procedure as above:
• From the Menu bar, choose: Slide
• A drop down menu appears
• Choose, “Slide -> Change Transition”

Viewing The Presentation In The Browser:

• You can view (present) the presentation right in the
browser

• Click “Present” in the top right of the Menu Commands
• A drop down menu allows you to choose:

• Present from beginning
• Present with speaker notes
• Present in new window

• You can also present in full screen mode by
clicking on the menu command, “View” -> Present

• Or, you can use key commands:
• Mac: Command + Return Key
• PC: Control + Enter Key

In Presentation Mode, You Can Navigate Through 
Slides :

• When viewing the presentation “full screen,” you
can navigate through slides by:

• Clicking the mouse
• Using the arrow icons in the bottom, left of

the screen
• Using the small menu in the bottom, left of

the screen to choose different slides (not in
sequence)

• Just click on the slide number you want
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In Presentation Mode, You Can Download And
Print The Presentation.

• When viewing the presentation full screen, click
the gear icon

• You will be given choices to:
• Open speaker notes
• Print the presentation
• Download the presentation as a PDF
• Download the presentation as a PPTX

Adding Animations:

• You can add animations to both text and images
• Text can come in on click or automatically
• Images can do the same

• You have choices for effect, speed, and whether
objects start to animate with or after other objects

• Text can come in by line or paragraph

Inserting Hyperlinks:

You can create links to webpages.
• Choose a word or phrase you would like to use as a 

hyperlink; highlight the words
• In the example, the words, “Click to read more” have 

been highlighted
• Click the “Link” icon in the toolbar
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This window appears
• Type the url for the webpage you wish to link to
• Or, choose one of the suggestions Google is providing 

for you
• Click the “Apply” 

• Close the window
• The words you highlighted have become a link

• Click on the words you highlighted to test the link
• A drop down appears with the URL you just typed
• Click on the URL to test the link
• Note: This drop down does not appear in your 

finished version. You will only see a hyperlink

• When the user clicks on the hyperlink you made, it will take the user to the page of additional information you 
have selected.

• You can create several links this way to assist students with additional resources on the WEB

Tools:

The “Tools” in the Google Toolbar have features which offer several choices and are especially helpful. They offer 
editing techniques which help make the documents look more polished. They also offer features such as spelling, 
dictionary definitions, and research tool. The nice thing is that there is no need to close the presentation to access 
these features. Example: Students can look up word definitions without closing the file and accessing a different 
application. 
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Check Spelling:

• As you type, if words are misspelled, a red line appears underneath the word

• Click on the word to see a drop down menu of suggested 
spellings. 

• If you are using “special vocabulary” that the dictionary 
does not recognize, you can add words to the dictionary

Dictionary Definitions: 

You can look up dictionary definitions without closing the presentation. This is helpful when writing and editing 
because it saves time.
• Highlight the word you wish to look up
• Tools -> Define

A sidebar opens with dictionary definitions, synonyms, and pronunciations.  You may also be given links to 
definitions on the WEB. 

Inviting Collaborators: 

You can invite others to collaborate on the presentation. 
When inviting others to collaborate on your presentation, 
you can choose whether to allow them to edit or just view 
the presentation.  You decide what permissions people will 
have.

• Click the blue “Share” button in the top, right corner of 
your presentation

• The following window opens:
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Type the email addresses of the people you choose as 
collaborators.
• If you invite more than one person, separate the 

addresses with a comma
• Choose “can edit” or “can view” or “can comment.”
• You can send an email which puts a hyperlink inside the 

email message the user can click on
• You can choose to add collaborators without sending a 

message
• You can add a message

Note: If you are within a Google Apps For Education 
domain, the names may populate for you automatically. 
When you start typing a name, you will see names appear. 
That way, you can click on the names of your choice 
without having to type the entire gmail address.

Collaborators Editing Presentations At The Same Time

When two or more people are collaborating, Google inserts a colored icon in the top, right corner of the window to 
represent each collaborator that is viewing the presentation. That way, users know if one of their collaborators is 
online while they are working on their documents.  Collaborators can edit in “real time” and see where their partners 
are typing.

Uploading Presentations: 

Drive allows you to upload a file you’ve created on your in Power Point. You do not need to create all the Slide 
Presentations from within Google Drive. This allows you to use presentations you’ve created in the past.  You can 
even choose a folder for the file to go into.

• Click the “upload button” in the Drive window
• Choose, “File”
• Note: If you use the Chrome Browser, you can also upload Folders
• You can also choose which Folder to place your presentations in while on this screen

• Another window opens, allowing you to select the files to upload. 
• Navigate to your hard drive and select the file to upload
• Click, “Open” to start the upload

• Google automatically starts the upload
• A window appears in the bottom, right corner of the Drive Homepage
• It shows the progress of the uploaded file or folder
• Google will even offer to send you an email if you have large files 

to upload, telling you the upload is completed

 If you wish to edit documents, you must “convert” them to Google 
presentations when you upload them. Only converted files can be 
edited online. Google allows you to upload any file type to be 
stored on your Google account. But, you must convert files to the 
“Google Slide format” so that you can edit the presentations 
online. This allows you to edit files that you created on your 
computer with Microsoft Word, Power Point, Excel, etc.

You can also save (download) presentations and files back to your 
computer. Google gives you choices in file formats. Note the six 
choices in the image at the right. One of the choices is to save your 
documents as Microsoft Power Point. They will open in Power Point 
once you download them to your computer.
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The Drive Homepage:

Google lists all the documents you create in the Drive Window.  You can see each file’s name, and you can sort 
them by date modified, title, last opened, or priority. You have viewing choices in this window.  You can choose to 
see files created only by you, shared with you, on the WEB, ones kept private, etc. You can also sort by type: text 
document, spreadsheet, presentation, drawings, etc. The drop down menus help you sort the documents.

In the image below, you can see a list of the various types of files that have been created. They are listed on the 
Drive homepage. Each file has an icon before its title. The icon represents which type of file it is: document, Form, 
presentation, spreadsheet, etc.

Other information:

1. Google also tells you how much of your available space you have used. 
2. You will see this when you click the “Upload” button
3. There are file size limits when uploading files:

• Docs - maximum of 1 MB per file
• Spreadsheets - maximum of 20 MB per file
• Presentations - maximum of 10MB per file
• Stored files not converted to Google Docs format - up to 1 gig each

4. Note: Some of the original formatting may be lost. Example: Presentations - transitions and custom animations 
will be lost.

  

 Google Slides Handout Page 13 of 14              © copyright 2014          Carol LaRow



Notes:
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